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© 1997 Extensis Corp o ration. This manual and the softwa re described in it are copy ri g h t e d
with all rights re s e rve d. Under the copy right law s , neither this manual nor the softwa re may
be copied, in whole or part,wtihout the written consent of Extensis Corp o rat i o n , ex c ept in the
n o rmal use of the softwa re or to make a backup copy of the softwa re. This ex c eption does
not allow copies to be made for others. Except as permitted by such license, no part of this
p u bl i c ation may be rep ro d u c e d, s t o red in a re t ri eval system, or tra n s m i t t e d, in any fo rm or by
a ny means, e l e c t ro n i c, m e ch a n i c a l , re c o rd i n g, or otherwise, without the prior written perm i s-
sion of Extensis Corp o ration. Po rtions of this softwa re are Copy right © 1990-97 A l a dd i n
S y s t e m s , I n c.

Extensis, the Extensis logo, and Extensis Preflight Designer Edition are trademarks of
Extensis Corporation. Quark and QuarkXPress are registered trademarks and XTensions is a
trademark of Quark, Inc. which have been registered in the U.S. patent and trademark office
and in many other countries. Apple and Macintosh are registered trademarks of Apple
Computer, Inc. All other trademarks are the property of their respective owners. All other
product names mentioned in this manual are used for identification purposes only and may be
trademarks or registered trademarks of their respective companies. Registered and unregis-
tered trademarks used herein are the exclusive property of their respective owners. 

Extensis warrants the disks on which the software is recorded to be free from defects in mate-
rials and faulty workmanship under normal use for a period of ninety (90) days from the orig-
inal date of purchase. If a defect occurs during the 90-day period, you may return the disks to
Extensis Corporation for a free r eplacement provided that you have previously registered your
product with Extensis Corporation. This warranty is limited to replacement and shall not
encompass any other damages, including but not limited to loss of profit, and special, inciden-
tal, or other similar claims. This software is provided on an “as is” basis. Except for the
express warranty set forth above, Extensis Corporation makes no other warranties, either
express or implied, regarding the enclosed software’s quality, performance, merchantability, or
fitness for a particular purpose.

Apple Computer, Inc. makes no warranties either express of implied, regarding the enclosed
computer software package, its merchantability or its fitness for any particular purpose. The
exclusion of implied warranties is not permitted by some states. The above exclusion may not
apply to you. This warranty provides you with specific legal rights. There may be other rights
that you have which vary from state to state.

When using fonts, you must abide by the fonts' licensing agreement. With the exception of
freeware and some shareware fonts, fonts are licensed for use on a single output device such
as a laser printer or other imaging device. If you need to collect fonts with Extensis Preflight
Designer and send those fonts with your files to a third party, you will need to upgrade, if you
have not already done so, to a multi-printer license, or ensure that the third party legally owns
the fonts to be used with your files. If you do not have a multi-printer license or if the third
party does not legally own the aforesaid fonts, then you may transfer the fonts from one com-
puter to another provided you only use the fonts on one computer at a time. You should also
notify the third party about complying with the license agreement that came with the fonts.
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Welcome to Extensis™ P re flight Designer Edition™! Yo u r
P re flight Designer program is the most advanced inspection and
collection tool ava i l able for graphic designers. It automat i c a l ly
gat h e rs key info rm ation from your document re l ated to RGB
i m ages and resolution issues, font ava i l ab i l i t y, and color usage.
All info rm ation gat h e red can be quick ly and compactly displaye d
for your ex a m i n ation. 

Even more importantly, you’ll no longer have to worry about
sending all the necessary fonts and images for your file to your
service provider, because with the simple click of a button you
can collect all the elements needed to print your job, including
embedded fonts and graphics. You’ll eliminate rework, improve
communication with your prepress house, and save precious time
and money—on every job!

System and Software Requirements

To install and use Extensis Pre flight Designer Edition, yo u ’ll need:

•   68040-based Macintosh® or newer, including
Power Macintosh®

•   8MB RAM minimum
•   System 7.5 or later 
• M i n i mum 1.5MB R A M for the Pre flight Designer ap p l i c at i o n
• Q u a rk X P re s s® ve rsion 3.3.1 or lat e r. 

The Preflight Designer Quark XTension must be placed in
the XTension folder for the copy of QuarkXPress that you
will be using. Refer to “Installation” for details.

Installation

For best results, turn off any unneeded extensions (by holding
down your Shift key while restarting your Macintosh) and all
anti-virus software. Be sure to keep any needed CD-ROM exten-
sions installed. Restart your computer.

Your Extensis CD-ROM contains other Extensis products ready to
be installed. These products are full working versions of Extensis
products that you can run in demo mode. Purchasing a serial
number from Extensis at (800) 796-9798 will allow these pro-
grams to be used without any time restrictions.

Introducing Preflight Designer Edition
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To install Extensis Preflight Designer

1. Insert the Extensis CD-ROM into your CD-ROM
drive.

2. Go to the appropriate Extensis Installer folder.

3. Go to the Preflight Designer folder.

4. Double-click the installer icon.

The Introduction dialog box appears.

5. Click the Continue button.

The Welcome dialog box appears. Release notes and spe-
cial instructions are displayed in this window. It is impor-
tant that you read these release notes since they contain
information not included in the manual. You should save or
print these release notes before continuing the installation.

6. Click Continue.

The Installation dialog box appears. 

7. Click the Install button.

The Disk Selection dialog box appears. The dialog box
requests that you select the disk on which you want the
Extensis product installed.

8. Select a disk.

Once a disk has been selected, you will need to locate the
folder into which you want to install Preflight Designer.

9. Locate QuarkXPress.

You will be asked to locate the copy of QuarkXPress that
you wish to use with Preflight Designer, so that the
Preflight Designer XTension can be installed in the proper
Quark XTension folder.

10. Click the install button.

Once installation is complete, the successful installation
dialog appears. The installer will prompt you to restart your
computer if necessary.
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Personalization and Registration

It is important to register your copy of Extensis Pre flight Designer so
we can provide you with serv i c e. Regi s t e red users of Extensis pro d-
ucts are eligi ble for technical support , i n fo rm ation rega rding new ve r-
s i o n s , p ro d u c t s , discounts and special offe rs on new pro d u c t s .

And Preflight Designer includes electronic registration, so regis-
tering has never been easier! The first time you launch Preflight
Designer after installing it, the Personalize dialog box appears. To
personalize your software, type your name, company and
Preflight Designer registration number. Your product registration
number is located on your Preflight Designer user guide. If you
choose not to personalize your copy, Preflight Designer will run
in a 30-day demonstration mode. A dialog box will remind you of
how many days are remaining in the demonstration mode.

Once you have personalized Preflight Designer, a dialog box
appears, asking if you would like to register. To register, click the
Register Now button; an electronic registration screen appears.
After you’ve completed the registration screen, a Market Research
screen and a System Configuration screen will follow. The Market
Research screen asks basic questions that enable us to better
understand your needs. The System Configuration screen provides
a “snapshot” of your system configuration that enables Extensis to
support you more effectively. Sending the Market Research and
System Configuration information is optional. If you do not wish
to send this information to Extensis, check the checkbox at the
bottom of these screens. 

To use electronic regi s t rat i o n , you must have a modem connected t o
your computer. Pre flight Designer will dial the number automat i c a l ly,
and the call is toll-fre e. If you do not have a modem, you can pri n t
the regi s t ration sheet and register either by faxing it to (503) 274-
0530 or drop it in the mail in the postage-paid envelope prov i d e d. If
you don’t have access to a modem or pri n t e r, you can still regi s t e r
by filling out the regi s t ration sheet located at the end of this manual. 

Preflight Designer Quickstart

To launch Preflight Designer, select “Preflight Designer” from the

Utilities menu in QuarkXPress. If a document is open in

QuarkXPress when Preflight Designer is selected from the menu,

Preflight Designer will launch and inspect the document. Or drag

a QuarkXPress document onto the Preflight Designer application,

or launch the Preflight Designer application, then locate a docu-

ment to open using the File menu. 
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Technical Support and Suggestions

For questions regarding Extensis Preflight Designer Edition,
please first refer to this manual, which describes the features and
basic operations. We invite you to visit our Preflight Designer
page on the Extensis website (www.extensis.com) for frequently
asked questions and troubleshooting tips.

If you have a question wh i ch is not add ressed in this manual or
on the Extensis web s i t e, Te chnical Support is ava i l able by phone
at (503) 274-7030 Monday through Fri d ay 8:00 a.m. to 5:00
p.m. Pa c i fic time. When calling for technical support, please be at
your Macintosh and have the following information available:
your Extensis Preflight Designer registration number, your
Macintosh configuration and your question or a description of the
difficulty you’re experiencing—what specifically occurs and
when. Take note of any displayed error numbers or messages and
any other information you think may be relevant.

We’d love to hear your comments about Extensis Preflight
Designer! For your convenience, a suggestion sheet is included a t
the end of this manual. Please fax, mail, or e-mail your comments
and suggestions to Extensis.

What is “Preflighting”?

Jobs that print or output proper ly in the hands of the designer, and
jobs that output properly to low or medium resolution printers,
very often will not output properly when transferred to a service
bureau or output facility, or will not print or output as the designer
had expected or hoped.

The output facility will almost certainly have completely different
computer systems and setups, different font configurations, differ-
ent—usually high or very high—resolution output devices, and
they may even be adding high resolution images in place of the
lower resolution images originally placed in the document by the
designer. Any of these differences, and many others, can sabotage
the job and cause problems in outputting or printing.

Preflighting is the process of making sure that all the elements
necessary for the job to output properly are in place, and that
problems in job documents that might keep them from outputting
p ro p e rly on high-end equipment have been accounted for and cor-
re c t e d. Pro blems with the output can be ve ry costly and time-con-
suming to fi x , and they become even more costly, in both delays and
actual costs, the further along in the production cy cle the job gets. 

Tip

We can also be reached via fax at
(503) 274-0530, or through the
online services listed below:

AOL: EXTENSIS
E-mail: support@extensis.com
I n t e r n e t :

h t t p : / / w w w. e x t e n s i s . c o m / s u p p o r t
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How Can Extensis Preflight Designer Help Me?

P re flight Designer automat i c a l ly gat h e rs key info rm ation fro m
your document re l ated to images and re s o l u t i o n s , fo n t s , a n d
c o l o rs , and displays this info rm ation for you at a glance. You can
e a s i ly determ i n e, for ex a m p l e, wh i ch RGB mode pictures have
not yet been conve rted to CMYK mode, an important task fo r
fo u r-color pri n t i n g. 

Without Preflight Designer you would need to open the document
and laboriously locate, select, and examine the parameters for
each picture. With Preflight Designer, you simply locate a picture
from the list and double-click it to produce a picture preview and
a detailed listing of all the important information related to that
picture, along with the page number(s) where the item is found.

But even more importantly, yo u ’ll no longer have to wo rry ab o u t
finding and collecting all the necessary fonts and images for yo u r
document to send to your service prov i d e r. With the simple cl i ck
of a button in Pre flight Designer you can collect all the elements
needed to print your job, i n cluding embedded fonts and grap h i c s .
Yo u ’ll eliminate rewo rk , i m p rove commu n i c ation with yo u r
p rep ress house, and save precious time and money.

How Does Preflight Designer Compare with

Extensis Preflight Pro™?

Preflight Designer essentially starts the preflight process by
inspecting a document to gather information about the document
and the elements used in the document. Preflight Designer then
allows you to examine the information that it collected. It is an
invaluable tool in collecting job elements (document, pictures,
fonts—even embedded fonts and pictures) for output, for sending
to a service provider, and/or for archiving. Preflight Pro does all
that, plus helps you identify, locate, and correct potential prob-
lems before expensive output equipment is engaged.

Additionally, Preflight Pro allows you to work with multiple files
in a job. You can: create and examine problem reports for selected
documents, pages, and elements in the job;  include or exclude
specific documents and/or pages from the preflight process; and
specify problem parameters for different output devices. So with
Extensis Preflight Pro you can find and fix potential output prob-
lems quickly, easily, and less expensively than ever before.

And, if you are using Preflight Designer and your service
provider is using Preflight Pro, you can team up to create a really
seamless transfer from design to final printing!
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Preflight Designer Steps Summarized

Preflight Designer is quick and easy to use. You can:

•  Examine information about elements in a job 
•  Collect a job
•  Enter Job Ticket information
•  Specify document Output Instructions (for use with

Preflight Pro)
•  Share your job with other Preflight Designer or Preflight

Pro users

1. Launch Preflight Designer in any of these ways:

•  Drag a QuarkXPress document onto the Preflight Designer
application icon

•  Select “Preflight Document” from the Utilities menu in an
open QuarkXPress document 

•  Double-click the Preflight Designer application icon, then
select “New Job” from the File menu

•  Select “Preflight Designer” from the Utilities menu in
QuarkXPress, then select “New Job” from the File menu

Preflight Designer will automatically launch QuarkXPress
and inspect your document, leaving it ready to be collected.

2. Wh at step you take next depends on wh at yo u ’d like to
do with the info rm ation gat h e red by Pre flight Designer.
You can:

• Examine the information gathered about the different
job elements (Pictures, Fonts, Colors) by clicking
through the tabs. You can hide the information display by
clicking the expansion arrow beneath the button bar.

• Collect the job by clicking the Collect button. Preflight
Designer will collect the job elements for archiving or
sending to the print facility. You can add or remove items
from the list to be collected, and you can elect to have
the collection compressed.

• Enter or view Job Ticket information by clicking the
Job Ticket button.

• Enter or view document Output Instructions (for use
with Preflight Pro) by clicking the Output Instructions
button. Note: Information entered here does not affect the
page setup instructions inside the document.

• Share the job with other users of Extensis Preflight
Designer or Extensis Preflight Pro.

Tip

You don’t need to worry about saving
your job—Preflight Designer does it
for you! New jobs are automatically
saved into the same folder as the
document, using the document name
and appending “.job” to it. And your
job is saved periodically as you work.
Of course you can always use the
“Save As…” command to save
and/or rename your job at any time.
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To Examine Information about Elements in a Job  

1. Create a preflight job using the document you wish to
examine.

Drag a QuarkXPress document onto the Preflight Designer
icon. Or select Preflight Designer from the Utilities menu
in an open QuarkXPress document. Or launch Preflight
Designer, then select “New Job” from the File menu (zN). 

Preflight Designer will launch QuarkXPress and inspect the
document. 

— or —

1. Open an existing preflight job and reinspect it.

Double-click a job icon to open it, or launch Preflight
Designer and locate the job. Reinspect the job by clicking
the Reinspect button. This ensures that information gath-
ered about the job is current, including any changes to the
document or system files since the last inspection.

2. Select the tab for the element you wish to view.

You can examine Pictures, Fonts, and Colors.

Note: If the Pictures, Fonts, and Colors tabs are not visible
in the window, access them by clicking the Show/Hide
arrow beneath the button bar.

3. Double-click an item on the list to open a detailed infor-
mation window about the item.

Show or Hide the Detailed
Document Information
window (containing the
Pictures, Fonts, Colors tabs)

Tip

To open a detailed information win-
dow for the document, hide the
Detailed Information window (the
area containing the Picture, Fonts,
and Colors tabs) and enter zI.

Tip

You can have Preflight Designer
leave your documents open in
QuarkXPress after inspecting them.
Simply select this option in Edit:
Preferences: General.

Using Preflight Designer Edition



To Collect a Job

1. Create a preflight job using the document you wish to
collect. 

Drag a QuarkXPress document onto the Preflight Designer
icon. Or select Preflight Designer from the Utilities menu
in an open QuarkXPress document. Or launch Preflight
Designer and locate the document. 

Preflight Designer will launch QuarkXPress and inspect the
document.

— or —

1. Open an existing preflight job and reinspect it.

Double-click a job icon to open it, or launch Preflight
Designer and locate the job. Reinspect the job by clicking
the Reinspect Document button. This ensures that informa-
tion gathered about the job is current, including any
changes to the document or file names/locations since the
last inspection.

2. Click the Collect Job button.

Preflight Designer will allow you to change collection
options, including whether or not to compress the collec-
tion. Next, Preflight Designer will determine which items
need to be collected, and it will give you an opportunity to
add to or remove items from the collection list. You will
then be asked to name the collection and determine where
to save it. When you are ready to collect the job, click
“Collect” to generate the collection.

12

Collect Job

Reinspect Document
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Edit Job Ticket

Edit Output Instructions

To Enter Job Ticket Information 

1. From an open job, click the Job Ticket button.

The Job Ticket includes important information such as:
who is responsible for the project; project due dates; job
pick up and delivery instructions; what media the document
will be output as, etc. The Job Ticket can be helpful for
anyone wanting to keep job information with their elec-
tronic job files, but it is particularly helpful when the job
will be sent to a service p rovider using Extensis Pre fl i g h t
P ro. In this case, i m p o rtant job info rm ation via the Job Ti cke t
will be automat i c a l ly ava i l able to the service prov i d e r
t h rough their Pre flight Pro progra m .

To Enter Document Output Instructions 

1. From an open job, click the Output Instructions button.

The output instructions for a document entered here will be
automatically checked against the document settings when a
problem report is generated using Extensis Preflight Pro. Or
the information can simply be viewed by another person
using either Preflight Designer or Preflight Pro.
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Sharing Jobs with Other Extensis Preflight

Users

You can easily share preflight jobs with other users, such as
between designers and clients, designers and service providers, or
between and within work groups, simply by collecting and send-
ing them. 

To Share a Job with Another User

1. Create a preflight job using the document you wish to
share.

Drag a QuarkXPress document onto the Preflight Designer
icon. Or select “Preflight Designer: Preflight Document”
from the Utilities menu in an open QuarkXPress document.
Or launch Preflight Designer, select “New Job” from the
File menu and locate the document. 

Preflight Designer will launch QuarkXPress and inspect the
document.

2. Collect the job by clicking the Collect button.

Verify or change collection options, including whether or
not to compress the collection, including whether or not to
compress the collection. Determine which items, if any to
add to or remove from the collection list. Click “Collect” to
generate the collection.

3. Send the collection folder (or .sea file, if compressed) to
another user.

The collection folder will contain the job file, the docu-
ment, and all the job elements (Fonts and Pictures) that you
indicated for collection in step 2. 

The job file can be opened in Preflight Pro, and a problem
report generated immediately. Preflight Designer users can
open the job file to review information gathered about the
collection.

Tip

You do not necessarily need to
collect your job (a collection includes
the job file, the document, and any
fonts and pictures you opted to
collect) in order to share with another
user.

If the other user only wants to see
the information gathered about the
document, or (using Preflight Pro)
generate a problem report, you may
only need to send the job file.

If the other user will be printing the
document or making corrections to it,
you should collect the job so that the
job file, the document, and at mini-
mum, the pictures, are available to
them.
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Preflight Designer’s electronically generated Job Jacket, similar to
the job jacket for a print job handled the mechanical way, includes
important information associated with a job such as document
information, output instructions, and job ticket info rm ation. In
a dd i t i o n , the electronic Job Ja cket in Pre flight Designer prov i d e s
access to all the info rm ation that can be gat h e red about elements in
the document (fo n t s , p i c t u re s , c o l o rs ) .

The Job Ja cket window is the pri m a ry window in Pre fl i g h t
D e s i g n e r. In addition to providing info rm ation about the document
and job elements, the Job Ja cket provides a convenient Button Bar
for quick access to the major operations in the progra m .

Working in the Job Jacket

The Job Jacket window is the primary
w i ndow in Preflight Designer. Displays
tabs for all job elements that information is
gathered for (Pictures, Fonts, Colors).
Displays information about the document
and the Preflight Designer Button Bar.

A Job Jacket title bar and “Job Name”

Basic Document Info

B Button Bar: Provides easy access to
Preflight Designer operations

C Show/Hide arrow: Shows or Hides the
detailed information windows (Pictures,
Fonts, and Colors information tabs)

D Help box: Informational window dis -
playing each button, column heading,
or icon function as the mouse passes
over it

E Document information area: Displays
Document name, document Status,
number of pages in the document, and
document width and height

Detailed Document Info

F Pictures tab

G Fonts tab 

H Colors tab

B

C

E

F G H

The Job Jacket window

A

D

▼ Detailed Document Info  (detailed info showing)

Basic Document Info  (detailed info hidden) 
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The Button Bar

The Button Bar provides access to major Preflight Designer oper-
ations. As you pass the mouse over each button, refer to the Help
box below the Button Bar for a short description of button func-
tion. Click a button to open up a dialog box or window to com-
plete the desired operation.

The Button Bar inside the Job Jacket win-
dow provides access to major operations.
Click a button to activate it.

A Extensis: Access information about
Extensis Preflight Designer 

B Open document: Opens the document
in QuarkXPress

C Reinspect document: Allows you to
inspect the document again.
Recommended after making changes
to the document

D Output Instructions: Open the Output
Instructions for viewing or editing

E Job Ticket: Open Job Ticket for view-
ing or editing

F Collect: Collect job elements 

The Job Jacket Button Bar

B CA E FD

Working with the Button Bar

To do this… Follow this procedure…

Reinspect the document. Click the “Reinspect” button. The document will be scanned and 
the information gathered. Completion time depends on document
size, processor speed, image size, and other factors. Or select
“Reinspect Document” from the Job menu.

Edit or view the Job Ticket. Click the “Job Ticket” button. Or select “Job Ticket” from the
Job menu, or press zT.

Edit or view the Output Instructions Click the “Output Instructions” button. Or select “Output
for the document. Instructions” from the Job menu.

Open the document in QuarkXPress. Click the “Open Document”  button. Or select “Open Document”
from the Job menu.

Collect the job. Click the “Collect Job Elements” button. Or select “Collect Job
Elements” from the Job menu, or enter zK.

Determine the function of a button Pass the mouse over the item. The item function will be shown in 
or area of the display. the Help box directly under the Button Bar.
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To Open a Detailed Info Window for the Document

1. With no items selected in the active tab (Pictures, Fonts,
Colors) select “Get Document Info” from the File menu,
or enter zI.

— or —

1. Close  the Detailed Document Information section of the
Job Jacket window by clicking the Show/Hide arrow.

2. Select “Get Document Info” from the File menu, or
enter zI.

Selecting “Get Document Info” from the
File menu, or entering zI, opens this
window.

A Document Info window title bar 

B Document name and location

C Document data:

Created date and time, Modified date
and time, Creator name, Type, 
number of Pages, document Height
and Width

D List of Document Items (job elements):
Pictures, Fonts, and Colors

E Job elements listed by category
(Pictures, Fonts, Colors). Click arrow
to expand/condense list.

The Document Info window

B

C

D

E

A
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Pictures

The Pictures tab lists all the pictures in the document and indi-
cates—for each occurrence of the picture—where it is used, the
type of picture it is, its status, and other information. Picture sta-
tus will be displayed as OK, missing, or modified.

The picture prev i ew displays the picture as it is in the ori ginal pic-
t u re fi l e, not including ch a n ges you might have made to it in
Q u a rk X P ress. You can save screen draw time and job file size by
electing to disable the prev i ew befo re the job file is cre ated (see
“Setting Pre fe re n c e s ” ) .

Use the Picture tab and the detailed Picture Info window to deter-
mine whether a picture is in the required mode (RGB, CMYK),
whether picture resolution is within acceptable tolerance, to deter-
mine what page(s) a picture is used on, picture file name and
location, to determine if a picture has been rotated or skewed, to
see what fonts or colors are used in the picture, to quickly pre-
view pictures, and much much more.

Working in the Pictures tab

The Pictures tab lists the pictures required
to output the job and displays their status.
Does not include unused pictures (such
as pictures on the pasteboard, or on an
unused Master Page).

A Pictures tab in the Job Jacket

B Name: Shows picture name

C Used in: Lists where the picture is
used. Indicates if a picture was used
in another picture 

D Page: Lists the page number the
picture was found on

E Type: Indicates the picture file type,
such as TIFF, EPS, PICT, DCS, etc.

F Eff Res: Effective picture resolution

G Mode: Indicates the color mode of the
picture, such as RGB, CMYK, bitmap,
grayscale, etc.

H Status: Indicates the current status of
the picture as OK, missing, modified

I Creator: Indicates the parent appli-
cation (application that created the
p i c t u r e )

B C E F G

The Pictures tab

A H ID
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To Open a detailed Picture Info window

1. Select the desired picture from the list of pictures on the
Pictures tab, then double-click it, or enter zI, or select
“Get Picture Info” from the File menu.

To Disable Picture Previews

N o t e : This action disables gat h e ring and storing of picture pre-
v i ew thumbnails in the job fi l e. Enabling this option can re d u c e
job file size. Does not affect prev i o u s ly gat h e red prev i ews. 

1. Select Preferences: General from the Edit menu.

The Preferences dialog will be displayed.

2. Click the “Disable Picture Previews” checkbox. A
checkmark in the box indicates that picture previews
will not be gathered when the job is inspected.

All prev i o u s ly gat h e red picture prev i ews will be continue to
be ava i l able even if this option is ch a n ge d. To re m ove picture
p rev i ew s , c re ate a new job file after selecting this option.

Double-clicking a picture, or selecting a
picture then choosing “Get Info” from the
File menu or pressing zI, opens this Pic-
ture Info window.

A Picture Info window title bar

B Information gathered about a picture:

File Name, File Location, Creation
Date, Modification Date, Picture
Creator, Document Used In,
Document Page, Picture Status,
Picture Type, Picture Color Mode,
Picture File Size, PicBox Origin
Across, PicBox Origin Down,
PicBox Height, PicBox Width, Picture
Width, Picture Height, Picture Scaled
Vertical %, Picture Scaled Horizontal %,
Physical Resolution, Effective
Resolution  (after scaling),
Background Color, Picture Color,
PicBox  Angle °, PicBox Skew °,
Picture Angle °, Picture Skew °,
Picture Flipped, Picture Styled,
Screen Transfer, Has Clipping Path,
Flatness of Path 

C Items used in the picture: Colors used,
Fonts used (in vector EPS files)

D Thumbnail preview of original file. A n
option under Preferences allows you
to disable the preview so that thumb-
nails are not gathered in the job file
and therefore will not display here.

B

C

The Picture Info window

A

D
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Fonts

The Fonts tab lists eve ry font used in the document, i n cl u d i n g
fonts used in pictures in the document. Font status is determ i n e d
by wh at fonts are curre n t ly ava i l able to the system. Font status is
u p d ated each time the Fonts tab is selected; you may notice the
font list being cre ated on the screen as the status of each font is
ch e cke d. 

Use the Fonts tab and the detailed Font Info window to determine
whether a particular font is used in document text, or in a picture,
to determine what colors are used with a particular font, whether
the document contains undesirable fonts, whether a font is cur-
rently available to the system, and much more.

Working in the Fonts tab

The Fonts tab lists fonts in the document
and displays their status. Does not include
unused fonts in the document, such as
fonts found in unused style sheets.

A Fonts tab in the Job Jacket

B Screen Font: Indicates the name of
the font

C Style: Indicates the style applied to the
font, if selected from a style menu

D Printer Font: Indicates the required
printer font for the listed screen font

E Type: Lists font type as TrueType,
PostScript, Multiple Master, etc.

F System Status: Reports on system
availability of both screen and printer
fonts

G Foundry: Indicates the font manufac-
turer. Helps ensure that the output
facility owns the same font.

H Version: Indicates font version

B C E

The Fonts tab

A

G HFD
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To Open a detailed Font Info window

1. Select the desired font from the list of fonts on the Fonts
tab, then double-click it, or enter zI, or select “Get
Font Info” from the File menu.

To Change Screen Font Status to “Available”

Preflight Designer checks for screen fonts every time you
leave the application then return to the Fonts tab.

1. Drop the required screen font onto the System Folder
icon, or open a font suitcase with a font program such
as Suitcase® or Adobe® Type Manager Deluxe™.

2. Return to your preflight job and select the Fonts tab to
verify that the font is now available.

To Change Printer Font Status to “Available”

Preflight Designer checks for printer fonts when the document
is inspected.

1. Drop the required printer font onto the System Folder
icon, or open a font suitcase with a font program such
as Suitcase or Adobe Type Manager Deluxe.

2. Return to your preflight job and reinspect the docu-
ment by clicking the Reinspect Document button.

3. Select the Fonts tab to verify that the printer font is
now available.

Double-clicking a font, or selecting a font
then choosing “Get Info” from the File
menu or pressing zI, opens this Font Info
window.

A Font Info window title bar

B Screen Font Name and Location

C Printer Font Name and Location

D Information gathered about this font:

Styles Applied, Font Type, Font
Status, Foundry, Font ID, Font Version

E Documents using this font         
Colors used with this font
Pictures using this font                

The Font Info window

B

C

A

D

E
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Colors

The Colors tab lists all the colors in the document, indicates color
name and type, and shows a sample of the color. Colors listed
may be used in pictures and/or type. Both spot and process colors
are listed.

C o l o rs listed as type “ P rinting Ink” a re either one of the pri m a ry col-
o rs (Cya n , M age n t a , Ye l l ow, B l a ck) or a Spot color. These are colors
t h at will ge n e rate a sep a rate plate when outputting sep a rat i o n s .

Use the Colors tab to count how many printing inks (plates) are
used in the document; to find out wh e re (pictures and fonts) col-
o rs are used; to determine wh at screen angle a color will be out-
put on; to rev i ew CMYK color values for each color, and more.

Working in the Colors tab

The Colors tab lists the colors in the job
and displays their type. Includes colors
from all pages in the document, including
unused pictures, such as on the paste-
board.

A Colors tab in the Job Jacket

B Color Sample: Shows an example of
what the color looks like

C Name: Lists color name

D Type: Indicates color type, such as
Printing Ink (Spot), Process

E CMYK: Lists the QuarkXPress CMYK
values for the color 

F Screen Angle: Indicates the screen
angle that the color will be output as

C F
A

The Colors tab

D

E

B



To Open a detailed Color Info window

1. Select the desired color from the list of colors on the
Colors tab, then double-click it, or enter zI, or select
“Get Color Info” from the File menu.

23

Double-clicking a color, or selecting a
color and choosing “Get Info” from the File
menu opens this Color Info window.

A Color Info window title bar

B Color sample

C Information gathered about the color:

Color Name, Color Type (Process or
Printing Ink), Screen Angle, CMYK
values, RGB values, Hue °,
Saturation %, Brightness %

D Documents where color is used
Pictures where color is used
Fonts where color is used

B

C

The Color Info window

A

D
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Document Output Instructions

Each document in your print job will include specific output
instructions, such as trim size, inks, and line screen. This output
information can entered into the job file so that Preflight Pro (if
used) can check it against the information contained in the
document. 

Information entered here is used by Preflight Pro to calculate the
number of printing inks used, find possible resolution problems,
and determine if the final trim size matches the page size indicat-
ed in the document.

Working in the Output Instructions dialog

The Output Instructions dialog allows you
to indicate how each document in the job
should be output. These values will be
checked against the values specified in
the document.

A Output Instructions title bar

B Printing Inks: Indicate CMYK and
Spot colors here

C Line Screen: Indicate Screen in Lines
per Inch here

D Trim Size: Indicate page Trim height
and width. Displays in inches. Enter
values in points, picas, mm, or cm.

E Cancel: Click here to close the Output
Instructions window without making
changes

F OK: Click here to save changes and
close the Output Instructions window

C

The Output Instructions dialog

A

D

E

B

F

Tip

Unless your preflight job will be run
through Extensis Preflight Pro, you
will probably not need to enter infor-
mation here.
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To Specify Output Instructions

1. Click the Output Instructions button, or select “Output
Instructions” from the Job menu.

2. Enter your instructions.

3. Click “OK.”

N o t e : C h a n ging the settings in the Output Instructions does not
ch a n ge settings in the Quark X P ress document.

Output Instructions
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Inspecting Documents

“Inspecting” a document causes Preflight Designer to gather all
the information from the document and job elements in the docu-
ment. When a new job is created, either by dragging and dropping
a document onto the Preflight Designer icon, or by selecting
“New” from the File menu in the Preflight Designer, or by select-
ing “Preflight Designer” from the Utilities menu in QuarkXPress,
the document is automatically inspected.

Using the tabs inside the Job Ja cket window you can ex a m i n e
i n fo rm ation that was gat h e red during the inspection rega rding doc-
ument para m e t e rs , fo n t s , p i c t u re s , and colors. To access these job
element tab s , cl i ck the Show/Hide arrow beneath the Button Bar.

I n fo rm ation gat h e red during the inspection is added to a dat ab a s e
of info rm at i o n , called the Job Fi l e, wh i ch is saved automat i c a l ly
when the inspection is complete. (“.job” is appended to the docu-
ment name to cre ate the job file name. )

To Reinspect a Document

1. Click the “Reinspect Document” button, or select
“Reinspect Document” from the Job menu.

P re flight Designer will launch Quark X P re s s , then open the
d o c u m e n t , gather the info rm at i o n , and ke ep you posted on it’s
p rogre s s . When the inspection is complete, P re flight Designer
will close the document, if it was closed prior to inspection.

N o t e : If a document was open prior to inspection by Pre fl i g h t
D e s i g n e r, P re flight Designer will leave it open after inspection.
You can instruct Pre flight Designer to leave the document open
when the inspection is complete. Refer to “Setting Pre fe re n c e s .”

Reinspect Document
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Opening a Document

With Preflight Designer’s “Open Document” command you can
quickly open the document in QuarkXPress, right from within the
Job Jacket.

To Open the Document in QuarkXPress

1. Click the Open Document button, or select “Open
Document” from the Job menu. 

Relinking a Document

Preflight Designer keeps track of files by name and location. If a
document is renamed or moved while the job file is closed, it will
be listed as “Missing” in the document status area. You will need
to relink the document to the job file, as described below.

To Relink a Document

1. Open a job file. If the document is listed as “Missing,”
select “Relink Document” from the Job menu.

You will be asked to locate the missing document.

2. Locate the document, then click “Open.”

Open Document
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Setting Preferences

Using the Preferences settings in the Edit menu, you can specify
some default parameters for Preflight Designer such as the copy
of QuarkXPress to launch, configuring a Default Job Ticket and
setting the Default Output Instructions.

General Preferences

From the General Preferences you can decide:

• Whether or not you will be prompted to ve rify the document
Output Instructions when the job is cre at e d.

• Whether or not documents will be left open in QuarkXPress
after inspecting them.

• Whether or not the Picture Preview (as shown in the detailed
Picture Info window) will be gathered (and stored in the job
file) when the job is inspected. This option results in smaller
job file sizes. This option, when selected, will take effect the
next time the document is inspected.

• Whether to display measurements in inches or millimeters.
• Which copy of QuarkXPress (if applicable) will be used to

open documents for inspection.

To Change the General Preferences

1. Select Preferences: General from the Edit menu.

2. Indicate your desired options.

To specify wh i ch copy of Quark X P ress to use, cl i ck “ S p e c i f y,”
then locate the ap p ro p ri ate Quark X P ress ap p l i c ation. 

3. Click “OK” to save the selected options.



29

Default Ticket

Information entered into the Default Job Ticket will automatically
be applied to all new jobs after the Default Ticket has been
changed.

Use the Default Ticket to enter job information that is consistent
from job to job to save data entry time, then change the Job Ticket
information as needed for each document. 

If no information is entered into the Default Job Ticket, the Job
Ticket for all documents will initially be blank.

To Create or Change the Default Job Ticket

1. Select Preferences: Default Ticket from the Edit menu.

2. Enter the desired information.

C l i ck through the tabs one at a time and enter the ap p ro-
p ri ate info rm ation in each tab window. This info rm at i o n
will be assigned to documents in all future jobs as they are
c re at e d.

3. Click “OK” to save Default Ticket information.

Printing Job Information

The report printed by Preflight Designer includes all the informa-
tion gathered about the document, including: Job Ticket informa-
tion; Pictures, Fonts, and Colors information; and information
about the document itself. Since this report includes very detailed
information from the job file database, it can be quite lengthy.
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Working in QuarkXPress

You can create and open preflight jobs without ever leaving
QuarkXPress. 

To Create or Open a Job from QuarkXPress

1. Select “Preflight Designer: Preflight Designer” from the
Utilities menu.

If Preflight Designer is not open, it will be launched. If
Preflight Designer is already open, it will be brought to the
front as the active window.

From Preflight Designer, select “New Job” (zN) from the
File menu.

2. Locate the document you wish to inspect or collect, or
locate an existing job to open.

To Create a New Job Using the Current Document

1. From QuarkXPress, bring the document you wish to
inspect or collect to the front.

2. Select “Preflight Designer: Preflight Document” from
the Utilities menu.

If Preflight Designer is not open, it will be launched, a new
job will be created using your document name with “.job”
appended to it, and the document will be inspected.

If Preflight Designer is open, it will be brought to the front
as the active window, a new job will be created using your
document name with “.job” appended to it, and the docu-
ment will be inspected.
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The Job Ticket is the place where all the information about a job
that is not associated with job elements (Pictures, Fonts, Colors)
is kept. Job Ticket information is not required, but when used, it is
usually hand-entered by a human being.

The electronically generated Job Ticket in Extensis Preflight
Designer (and Extensis Preflight Pro), just as with the job ticket
for a print job handled the mechanical way, includes such impor-
tant information as: who to contact with questions; due dates;
pickup and delivery instructions; how the files were received;
additional items sent with the job, such as artboards; what media
the job will be output to prior to printing, etc.

This info rm ation can be entered by the designer prior to sending the
job to the service prov i d e r, by the service provider staff prior to
sending the job to the production fa c i l i t y, e t c.

The job ticket window consists of the following tabs:

• Contact—includes particulars about the client, including
company name, primary contact, creator/author, and billing
address.

• Order Info—includes job name and number, dates received
and due, information about the job, and billing information.

• Delivery—includes shipping address for completed job,
along with information on carrier type, ship method, and
account number if applicable.

• Media—includes information about the media on which the
job is supplied, such as the type of disk, and any additional
materials supplied, such as artboards, color proofs, etc. The
output media section of this tab allows you to indicate
whether the job will be output to film or RC paper, as a laser
proof, as separations, etc.

• Instructions—allows you to enter text-based information
pertinent to the job.

To Create, Edit, or View a Job Ticket:

1. Click the “Edit Job Ticket” button, or select “Job
Ticket” from the Job menu, or press zT.

2. Click the Job Ticket tab of your choice, then enter or
examine the desired information.

Edit Job Ticket

Filling Out the Job Ticket
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Entering information in the Job Ticket window and Contact tab

Entering information in the Order Info tab

The Job Ticket window displays tabs for all
the information that can be entered in the
Job Ticket. 

A Job Ticket window title bar

B Contact information tab

C Order Info tab

D Delivery information tab

E Input and output Media tab

F Instructions tab

The Contact tab contains information about
who is responsible for the job and how to
reach them.

G Enter Company Name 

H Enter Primary Contact information 

I Enter Creator/Author information 

J Enter Billing Address information 

B C

I

J

E F

G

H

The Job Ticket and Contact tab

A

D

The Order Info tab contains information
about the job order.

A The Order Info tab inside the Job
Ticket window

B Enter job numbers associated with
this job

C Enter job description information

D Enter billing information associated
with this job

E Enter order input contact information 

F Indicate Rush or Call When Ready

G Enter job date and time information

B

C

E

F

The Order Info tab

A

D

G
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Entering information in the Media tab

Entering information in the Delivery tab

The Delivery tab contains information about
how the completed job will be delivered
back to the client.

A The Delivery tab inside the Job Ticket
window

B Enter Delivery information including:

• Customer Pickup
• Courier or Private Carrier pickup,

type of carrier, contact information, 
type of delivery, and Account number  

C Enter the address where the job is to
be delivered

B

C

The Delivery tab

A

The Media tab contains information about
both the input media and output media.

A The Media tab inside the Job Ticket
window

Input Media:

B Enter type of electronic media the job
was delivered to the shop on, such as
SyQuest, Zip, Jaz, Optical, Internet

C Enter information about other media
delivered with the job, such as proofs or
artboards, and indicate whether sup-
plied images are For Placement Only, to
be replaced with high-resolution images

Output Media:

D Indicate whether cropping and registra-
tion marks are required, and whether to
output job in spreads 

E Enter information about proofs, if proofs
are required for this job

F Enter information about the media to be
output for this job, such as Film or RC
paper, and film specifics

B

C

F

The Media tab

A

D E
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Default Job Ticket

You can specify a Default Job Ticket by selecting “Default
Ticket” from the Edit: Preferences menu. The information you
specify will become the Job Ticket for all new jobs created. You
can then edit the Job Ticket and make changes as appropriate.

Entering information in the Instructions tab window

The Instructions tab provides a place to
enter any special instructions for the job.

A The Instructions tab inside the Job
Ticket window

B Enter any special instructions that
apply to this job

B

The Instructions tab window

A



Using the Collect Job function, Preflight Designer gathers togeth-
er all the elements required to output your job, including the doc-
ument itself, the job file, and pictures and fonts in the job.

When you create a collection, you can choose not to collect pic-
tures and/or fonts, and you can add or delete files from the list of
items to be gathered.

You can save time and disk space by having Preflight Designer
automatically compress the collection (using the popular com-
pression utility StuffIt® by Aladdin Systems) after the items are
gathered. You can also have Preflight Designer automatically bin-
hex the archive if that format is required, possibly to transfer the
archive electronically.

Collecting the Job

The Collection Setup dialog allows you to
indicate which items will be collected, and
whether or not the collection will be com-
pressed.

A Collection Setup dialog title bar

B Collection options: Options are
Collect Pictures, Collect Embedded
Pictures, and Collect Fonts

C Compression options: Options are
Compress into Self-Extracting Archive
and Convert compressed archive to
BinHex

D OK: Click here to accept the indicated
choices and start the collection
process

E Cancel: Click here to cancel the col-
lection process 

The Collection Setup dialog

E D

B

C

A

35
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Working in the Collection Preview dialog

The Collection Preview dialog shows all
the files that will be gathered in the collec-
tion, and allows you to add or remove files
before the collection is gathered.

A Collection Preview window title bar

B Files to Collect: Lists files that will be
added to the collection

C Size: Shows the pre-compressed size
of each file in the list

D Documents: Displays the document
being collected

E Pictures: Lists all Pictures that will be
collected

F Fonts: Lists all Fonts that will be col-
lected

G Collect: Click here to start the collec-
tion. You will be asked to indicate
where to store the collection

H Cancel: Click here to cancel the col-
lection process

I Add: Click here to locate files to be
added to the collection

J Remove: Select the file to be
removed, then click here to remove it
from the list of items to be collected.

The Collection Preview dialog

D
G

H

I

JF

E

A

B C

The Job Collection is the folder or archive
that contains all the files gathered in the
collection.

A Job Collection Folder: This folder takes
on the name of the Job file, unless
specified otherwise when the collection
is gathered

B Job Collection Archive: The collection
folder shown in A is compressed as a
StuffIt archive when “compress col -
lection” is selected during the collec-
tion process

C Job Collection Folder contents:
Includes the Job File and folders for
each of the items that can be collect-
ed (Document, Pictures, and Fonts).
Note: If no elements are collected in
a particular category (such as
“Fonts”) no folder will be created for
that category. Collection category
folder names are always preceded by
“~”.

The Job Collection

A C

B
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To Create a Collection

1. In the Job Jacket window, click the Collect Job button
or press zK, or select “Collect Job Elements” from the
Job menu.

2. Indicate (or verify) whether Pictures, Embedded
Pictures, and/or Fonts will be collected. Also indicate
whether the collection will be compressed, and if com-
pressed, whether or not to convert the archive to
BinHex format.

Preflight Designer automatically collects the Document in
the job along with whatever items you indicate here (and
the items you indicate in the list of items to be gathered, as
shown on page 39). You can collect all the Pictures,
Embedded Pictures, and Fonts in the document. 

3. Examine the files to be collected, and add or remove
files as desired.

Collect Job

Tip

Preflight Designer does not collect
fonts or pictures only used on master
pages or style sheets, or located
completely on the pasteboard.
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4. Click “Collect.”

When you have finished adding to or removing items from
the list, or if you have no items to add or remove, click
“Collect” to have Preflight Designer gather the items.

5. Determine where to store the collection, then click
“Save.”

B e fo re Pre flight Designer actually gat h e rs the collection,
you will need to indicate wh e re the collection is to be store d.
L o c ate the disk drive and/or folder wh e re the collection is to
be store d. Click “ S ave ” to begin collecting job elements.

To Compress (archive) a Collection

1. Start the collection by clicking the Collect Job button.

2. Verify or change collection options, then select appro-
priate Compression options.

If you wish to compress the collection (cre ate a self-ex t ra c t-
ing arch ive ) , cl i ck the “ C o m p re s s … ” ch e ck b ox. To also
c o nve rt the arch ive to BinHex , cl i ck the “ C o nve rt … ” b ox .

Note: You cannot select “Convert to BinHex” unless the
collection is also compressed.

3. When you have finished with the Collection Setup
options, click “OK” to continue with the collection
process.

Compression
options

Collect Job



To Add Files to the List of Items to be Collected

1. Start the collection by clicking the Collect Job button.

2. Verify or change collection options, then click “Collect.”

3. When the Collection Prev i ew window ap p e a rs , cl i ck “A dd.”

4. Locate the file(s) to be added, then click “Open.”

5. When you have finished adding files, click “Cancel” to
return to the Collection Preview window.

This adds the file(s) at the end of collection list under the
heading “User Files.”

6. Click “Collect” to continue with the collection process.

Note: The files you add to the list of items to be collected
are placed in a separate folder inside the archive.

To Remove Files from the List of Items to be Collected

1 . S t a rt the collection process by cl i cking the Collect bu t t o n .

2. Verify or change collection options, then click “Collect.”

3. When the Collection Prev i ew window ap p e a rs , select the
file(s) to be re m oved from the list, then cl i ck “ R e m ove.”

The files you “remove” will not be gathered along with
other files when the job is collected.

4. When you have finished removing files, click “Collect”
to continue with the collection process.

39

Remove files from list

Add files to list
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Collecting Embedded Pictures

Preflight Designer offers you the option of adding embedded pic-
tures to the collection. You must elect to collect all picture files to
enable the embedded pictures option.

When a picture is embedded in an EPS picture, the current path to
the embedded file is entered into the EPS file. If the embedded
file is in the same physical location during the collection process
as it was when it was embedded, it is available for collection. If it
has been moved or renamed, it is not available and cannot be
collected.

The disk file for an embedded file is generally not needed to
properly output the EPS, but if a change needs to be made to it,
such as converting it from RGB mode to CMYK color mode, the
original image must be available. If the disk file for an embedded
file has been renamed and you want to include it in the collection,
you may want to use Preflight Designer’s “Add to collection” fea-
ture described on page 39.

Note to Preflight Pro users: In Preflight Pro’s Picture File Profile
item “Disk file for an embedded picture is missing,” the pictures
listed for this item in the Report window will be the original disk
files for the picture(s) embedded in a picture, if a disk file ever
existed. Some embedded pictures are pasted on the page and have
no associated disk file.
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E
Edit

Job Ticket, how to   31-34
Eff Res

of a Picture, where shown   19
Embedded Pictures

collecting   37
explained  40

Equipment needs 5

F
Font   see also Font Info window, Fonts tab

Foundry name, where shown   20, 21
info window   21
information gathered about   21
Printer Font name, where shown   20, 21
Screen Font name, where shown   20, 21
Style applied, where shown   21
System Status of, where shown   20, 21
tab described   20
Type, where shown   20, 21
Version of, where shown   20, 21

Font Info window
accessing   21
described   21

Fonts tab
accessing   20
described   20
opening detailed info window   21

Foundry
of font, where shown   20, 21

G
General Preferences 

described   28
setting   28

I
Inspect   see also Inspecting documents

see also Reinspecting documents
button described   16, 26
command described   16, 26

Inspecting documents
automatically   11, 26
how to    26

Installation   5-6
Instructions

adding to Job Ticket 31, 34
tab described 34

B
Button Bar

icons defined 16
functions described   16

C
Collecting Job Elements   see also Collection

button described   16
described   35-40
menu command   37

Collection
button described   16
creating a, how to   37-38
Collecting job elements, how to   12, 37-39
compressing a, how to   38
folder contents   36
items collected   14, 36
Preview dialog   36

Color mode, of a picture
where shown 18, 19

Colors
info window   23
information gathered about   23
tab described   22

Compressing a collection see also Collection
how to   38

Contact
tab described     32

Creator
of Picture File, where listed   18, 19

CMYK
color values, where shown   22, 23
mode discussed   18
mode, where shown   18, 19

D
Default

Job Ticket   see Job Ticket
Default Ticket   see also Job Ticket

menu command   29, 34
Delivery tab   33
Disable Picture Previews option   19, 28
Document

name, where shown   15, 17, 18, 19, 21, 23,
36, 37, 39

Document Info window
accessing   11, 17
described   17

Index



J
Job

Collection   see Collection
creating a new   11-13, 30
File, creating   11-13, 30
Jacket   see Job Jacket
Ticket   see Job Ticket

Job Jacket
Button Bar   16
Colors tab described   22
Fonts tab described   20
Pictures tab described 18
window described   15

Job Ticket
creating   31
Default ticket   29, 34
described   31-34
editing   31
menu command   31
tabs described   31-34
window described   31

L
Line Screen

in Output Instructions   13

M
Media 

tab described 33
Mode

of a Picture 18, 19

N
Name

of color, where shown  19, 22, 23 
of document, where shown   15, 17, 18, 19,

20, 21, 23, 36, 37, 39
of fo n t , wh e re shown   1 9 , 2 0 , 21 
of picture, where shown   18, 19, 21

New job , creating a   11-13, 30

O
Open document

command described   27
how to   27

Open a job
how to   10, 11, 30

Order Info tab   32
Output Instructions

button described   16, 24
specifying   24

P
Page

Picture found, where shown   15, 18, 19
Personalizing 

Preflight Designer Edition   7
Picture Info window

accessing   19
described   19

Picture Preview
accessing   19
disabling   19, 28
file size related to   19

Pictures   see also Pictures tab
information gathered about   18, 19

Pictures tab
accessing    18
described   18
opening detailed info window   19

Preferences
Default Ticket   29
Disable Picture Previews   28
Display measurements in inches/mm  28
General, setting   28
General, described   28
Leave documents open in QuarkXPress   28
Prompt for Output Instructions   28
setting   28-29
Specify copy of QuarkXPress   28

Preflighting
defined   8

Preflight Document
menu item, in QuarkXPress   30

Preflight Designer
menu item, in QuarkXPress   30
XTension, where placed   5, 6

Preflight Pro
comparison with Preflight Designer   9
sharing jobs with users of   14

Preview of picture
accessing   19
disabling   19, 28
file size related to   19

Printer Font
name, where shown   20, 21

Printing Ink
defined   22
in Output Instructions   24
type, where shown   22, 23

Q
QuarkXPress

Creating and opening jobs from   10, 30
Preflight Designer menu in   30
Preflight Document menu item   30
XTension for Preflight Designer   5, 6
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V
Version

of font, where shown   20, 21

X
XTension

for Preflight Designer, where placed   5, 6

R
RGB mode

about   9, 18, 40
where shown   18, 19

Relinking Documents   27
Remove Documents

from Collection list   39
Registering Preflight Designer

electronically   7
Registration Form   Back of manual

Resolution of a Picture
where shown   19

S
Screen Angle   see also Colors

of a color, where shown   22, 23
Screen Font    see also Fonts

name, where shown   20, 21
Setting Preferences   see Preferences
Software Requirements   5
Spot Color

defined   22
in Output Instructions   24

Sharing Files 
described   14
how to   14

Status
of document, where shown   15
of Picture, where shown   18, 19

Style
of font, where shown   20, 21

Suggestions
how to make   8
submission form   Back of manual

System Requirements   5
System Status

of font, where shown   20, 21

T
Technical Support

contacting   8
website address   8

Thumbnail Preview see Picture Preview
Ticket   see Job Ticket
Total

pages in a document, where shown   15, 17
Trim Size

in Output Instructions   24
Troubleshooting info, where to find   8
Type

of color, where shown   22, 23
of font, where shown   20, 21
of picture, where shown    18, 19
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Registration

If you haven’t already registered, please complete the following regis-
tration information, tear along the perforation and fax to (503) 274-
0530 or drop it in the mail in the postage-paid envelope provided. Your
product registration number is located on the back of your manual.

■■■-■■■-■■■-■■■-■■■-■■■

Name

Organization

Street Address

City State Country Zip/Postal Code

Daytime Phone Daytime Fax

e-mail (optional) 

Platform (check all that apply)

■ Macintosh                ■ Wi n d ows            ■ Other _________________

Applications Used (check all that apply)

■ Q u a rk X P ress        ■ Page M a ker        ■ Photoshop        ■ I l l u s t rator       ■ Fre e H a n d
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Suggestion

We’d like to know what you think we could do to make Preflight
Designer better. So if you have an idea for a new product feature, a
modification to an existing one, or anything else you can think of that
will help us make this product better—we’d like to hear from you.

To help make Preflight Designer Edition better,

please...

1. Print your name, address, and phone number below and sign your 
name.

.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

Name

Street Address

City State           Country                              Zip/Postal Code

Daytime Phone Daytime Fax

Thanks for your suggestions! Hopefully you’ll see your ideas in future
versions of this or other Extensis products.
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